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A. Overview	

SiteWorx/OS models the existing and proposed surfaces from elevations and areas recorded from the 
grading plan. The differences in the surface models provide the location and quantities of soil movement. 
 
The program features available depend on the file type. SiteWorx/OS works with both raster and vector 
type drawing files. This tutorial will demonstrate a takeoff using a multipage PDF vector file. Information 
about trenches, bore logs and importing elevations from a DWG file are also covered in this tutorial.  
 
We highly recommend working through this tutorial step by step. Press the F1 keyboard key for context 
sensitive help or click the small blue circle with the question mark in the far top right-hand corner of the 
window and then click the mouse when over a command for help. If you have any questions or problems 
whatsoever, please contact us at 800-989-4243, 214-340-9436 or support@vertigraph.com.  
 
Wishing you the best of everything. Good luck.  
 

B. About	the	SiteWorx/OS	Window	

1. Help 

2. File Menu 

3. Tabs 

4. Toolbar 

5. Menus section of the Toolbar 

6. Work Area 

7. Status Bar 
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1. Help 
The question mark in the top right corner of the window provides context sensitive help. Click 
the question mark and then click a menu or toolbar command for explanation. The F1 keyboard 
key also provides help.  

 
2. File Menu/Icon 

To open, save or start a new project, click on the file menu/icon found on the top left-hand 
corner of the window.  

 

3. Tabs  
The tabs at the top of the window are named Project, Drawings, Takeoff, Calculations, 3D 
View, Cross Sections, Grid Data and Soil Analysis. Work from left to right along the tabs. 
Start at the Project tab, where the project is named. At the Drawings tab, files are opened and 
the scale is set. The Takeoff tab is where elevations and areas are recorded from the drawing 
file(s). Much of the work is done at the Takeoff tab. Each tab is covered in this tutorial.  
 

4. Toolbar 
The toolbar ribbon underneath the tabs contain the program commands. Each tab will have a 
unique toolbar. The toolbar is divided into sections; the various section names are noted at the 
bottom of the toolbar.  
 

5. Menu Section of the toolbar 
The right side of the toolbar contains the SiteWorx/OS menus. To learn more about the 
commands on the menus, click the help question mark in the top right-hand corner of the 
window, move the question mark pointer over the menu and click; or press the F1 keyboard 
key.  
 

6. Work Area 
The work area is the portion of the SiteWorx/OS window between the toolbar at the top and the 
status bar at the bottom. Data is entered, edited and results are analyzed in the work area.  
 

7. Status Bar 
The status bar is at the very bottom of the window. The status bar displays from left to right: i) 
Instructions and status messages pertaining to the current activity ii) Project file name iii) 
Drawing file name and iv) Notation that identifies how the image is rendered – RASTER, PDF, 
Vector PDF or CAD.  
 
 

C. 	File	Types	‐	Raster,	Vector	and	PDF	Files	

SiteWorx/OS works with both raster and vector drawings. Knowing about these file types is important 
in understanding how SiteWorx/OS works and what features are available.  

Raster File Images 

What is a raster image? A raster image is a grid of tiny pixels. A pixel is defined as a point of color. 
More pixels per inch means higher resolution. Raster files are similar to a printed document where the 
image is created by a collection of tiny ink dots. Digital photos and scanned blueprints are always raster 
images. Raster files have the following file extensions: .TIF, .BMP, .JPG, .PNG and sometimes .PDF. 
When viewing a drawing with SiteWorx/OS, the status bar at the bottom of the window displays, on the 
right side, how the file is displayed or rendered. All raster files with be noted as either Raster or PDF 
on the SiteWorx/OS status bar. When taking off items from raster drawings, the estimator clicks on the 
tiny pixel dots on-screen to set apart the contours, points and areas.  
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Vector File Drawings 

Vector drawings are very different than raster images; and a vector drawing is not rendered by using 
points of color (i.e. pixels) organized in a tiny grid like raster images. 

Computer Aided Design Programs, such as AutoCAD, create vector drawings that are rendered by 
displaying objects, that are also known as “entities”. The various entities are organized by logical 
layers. These entities are created by a list of points. Various attributes are assigned to these layers, 
entities and points through the CAD software. Generally, the layer attributes define the color, line style 
and line width. The entity attributes include the type of entity – which may be a point, line, polyline, 
polygon or text. And the point attributes provide the x,y,z positioning of the point. When taking off 
items (i.e. entities) from vector files with SiteWorx/OS, the user isolates the desired layer and then 
selects the entity or snaps to a point within the entity.  

PDF Files 

There are two types of PDF files, raster or vector, and the type of PDF file depends on how the PDF file 
was created. When a PDF file is created through the CAD program, the PDF drawing maintains the 
layers, entities and points defined in the CAD file. Some, but not all, attributes may also be recorded to 
this PDF file. Whenever a PDF file is created from the CAD drawing and there is more than one layer, 
the PDF file will be rendered as a vector type PDF file which contains layers and objects (aka entities). 
When the PDF file is created from raster images or scanned from blueprints, the PDF file will be a 
raster type PDF file rendered with points of color (i.e. pixels). 

Vector files are noted in SiteWorx/OS as PDF Vector or CAD on the lower right corner of the status 
bar found at the bottom of the window. Vector type PDF files will have a Vector PDF section added to 
the Takeoff toolbar ribbon. An AutoCAD file, which are always a vector drawing, will have a CAD 
section added to the SiteWorx/OS toolbar. When digitizing items from vector files, you’re able to 
isolate design layers and eliminate non-relevant information found on the image. When taking off 
contour lines, using the select entity command takes off the entire contour line with a single click.   

If the vector file, such as AutoCAD DWG or vector PDF are available, we highly recommend that you 
use these vector files instead of raster files. In general, your takeoff will be faster and more accurate 
with vector files. 

When opening a file with SiteWorx/OS, how the file is rendered or displayed is disclosed on the bottom 
right corner on the status bar. The file will be rendered as one of the following: 

 

 PDF for raster type PDF files 

 Raster for non-PDF raster files such as TIFF, JPEG, BMP, PNG and others 

 PDF (Vector) for vector type PDF files 

 CAD for DWG, DXF and other Computer Aided Design files which are always vector files 

 
This tutorial demonstrates a complete takeoff using a multipage PDF (Vector) file. Towards the end of 
the tutorial, importing objects from an AutoCAD.DWG drawing file is also covered.  
 
Now let’s get started …  
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D. 	Project	Tab	

Start the takeoff at the Project tab. All you need to do here is name the project as “Tutorial 
Project” or whatever in the Project field. Information entered here appears on the reports. The 
Boring Logs and Trench settings noted on the right-side of this window, are job specific settings 
and are changed only when needed. Working with bore logs is covered in the Boring Logs section 
of this tutorial; and trenches are covered in the Trenches chapter. 
 

E. 	Drawings	Tab	

After naming the project at the Project tab, the Drawings tab is where files and/or pages are opened.  
 
After clicking on the Drawings tab, the user may be asked to save changes to the current project. 
Answer Yes and name the file as “Tutorial” and click the Save button. Please note that all 
SiteWorx/OS file names end with a .ves extension.  
 
This tutorial walks through a project using the installed Top of Curb Multipage.pdf drawing file which 
is a vector type PDF file.  

Step	1	‐	Open	the	drawing	files	
 

  
 
Click the Open… button on the left side of the Drawings tab toolbar to find and open page 1 of the Top 
of Curb Multipage.pdf file. 
 

 
 
The tutorial drawing file named Top of Curb Multipage.pdf is found at C:\Users\Public\Public 
Documents\Vertigraph\SiteWorxOS\Drawing Files. Clicking the Drawings icon at the far-left side 
of the Open Drawing File window displays the files in this Drawings folder. After finding the Top of 
Curb Multipage.pdf file, click on the file name to display the preview image on the right side. Please 
Note: If the preview does not display, click the Show Preview tool  on the top-right side of the Open 
Drawing File window.  
 
When working with files that contain multiple pages, the first page of the file will display with the page 
number found underneath the preview at the bottom-right side of the window  . Simply navigate 
through the pages using the up and down arrows to preview the desired page. This tutorial project uses 
one file with multiple pages. As a result, after the page 1 preview displays, click the OK button at the 
bottom to open and display page 1 of the drawing file.  
 
The active drawing name and location are shown on the status bar at the bottom right-hand side of the 
window. How the file is rendered (i.e. either as a PDF, Raster, PDF (Vector) or CAD) is also shown on 
the status bar. This multiple page file is a vector type PDF file and as a result, will display PDF 
(Vector) on the bottom-right corner of the status bar. 
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Projects may contain a single drawing file or multiple drawing files or pages. In this tutorial, the 
existing elevations are found on page 1 and the proposed elevations are on page 2. As a result, page 2 of 
the file must also be opened and this tutorial project will use Multiple drawings. To open page 2 of the 
file, click the Open… command on the Drawing section of the toolbar, select the same file and change 
to page 2 at the bottom-right. After page 2 is displayed, click OK to add page 2 to the Active Drawing 
list. 
 
The list of pages and/or drawings opened and available are displayed by clicking the Active Drawing 
command on the top-left side of the Drawings toolbar. Page 1 and page 2 should now show on the 
Active Drawing list. Once the desired drawings or pages are opened and properly displayed on the 
Active Drawing list, DO NOT change the Page number since changing the page number will change 
the drawings found on the Active Drawing list. To change the desired page displayed, simply select the 
desired page or file from the Active Drawing list. 

Step	2	‐	Review	the	drawing	files	before	starting	
 
After the drawings are opened, review the drawings by selecting the file or page from the Active 
Drawing list to obtain a basic understanding of the project. To review a page that is not on the active 
drawing list, right click overtop the drawing displayed at the Drawings tab and select Duplicate 
Drawing from the popup menu and change the desired Page number on the Page section of the toolbar.  
 
IMPORTANT – Zooming and moving around (i.e. panning) the drawing quickly and easily is critical. 
Zooming in and out is done through the scroll wheel on the mouse. When zooming with the scroll 
wheel, the drawing will center on the screen wherever the mouse pointer is placed. The Zoom to 
Selection tool at the Zoom/Pan section of the toolbar is also a quick way to zoom. When zoomed in, 
move (i.e. pan) around the drawing by holding down the Ctrl keyboard key while dragging the mouse 
with the left mouse button depressed. Holding down the scroll wheel also pans the drawing.  
 
When reviewing the file(s) or page(s), determine the area of interest or project boundary where cuts or 
fills will occur. Where are the existing and proposed elevations different? Are there excluded areas? If 
there is more than one file or page, are there two common alignment points displayed on each drawing 
that can be used to align the first drawing opened to the other drawings? Is there anything that needs to 
be demolished and removed? Is there topsoil strip and respread required? Are project dimensions in 
meters or feet? Are there bore logs that need to be entered? Is there a known dimension available for 
auto-scaling? Are the areas flat or not flat? What subgrade material layers need to be placed under each 
area? Does the grading information come from one file page or does the data come from multiple file 
pages?  If multiple files – are there match lines or common alignment points? In summary, gain a basic 
understanding of the project by reviewing the drawing(s) before starting. 

Step	3	‐	Set	the	scale	
 
When working with multiple pages or files, the scale is set only on the first drawing opened which is the 
first drawing listed on the Active Drawing list. As a result, insure the first, Page 1, drawing is selected 
on the Active Drawing list. 
 
This first drawing on the Active Drawing list is known as the Base Drawing. To change which page or 
file is the first, base drawing for scaling, select any drawing except the first from the Active Drawing 
list, right click the mouse over the desired drawing and select Make Base Drawing from the popup 
menu.  
 
To set the scale, select the first drawing on the Active Drawing list (i.e. the Base Drawing) and then 
click the Scale button on the Scale section of the toolbar.  
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After clicking, a message will recommend autoscaling. To ensure accuracy, Autoscale should be used 
on all drawings.  
 

 
 
The scale units are defined as either English or Metric units. When Metric is selected, volumes are 
calculated as cubic meters rather than cubic yards, areas are reported as square meters instead of square 
feet and lengths are in meters instead of feet.  
 
To set the scale for this tutorial, select English and Engineering and click the yellow ruler, AutoScale 
button, and the drawing appears. Single click (do not trace) the beginning and end points of the 0 to 60 
scale legend located on the right side of the drawing under the direction arrow. After clicking the 
second point, enter the length of the line as 60 in the distance box on the toolbar and then click the 
green checkmark OK button on the Scale section of the toolbar. English auto-scale scale lengths are 
entered in decimal feet. For example, 25 feet, 6 inches is entered as 25.5 feet.  
 
After entering the distance and clicking OK, the scale factor displays. For general information, when 
English scales are selected, the true scale factor is equal to the reciprocal of the scale times 12. A true 
1:10 scale will have a factor of 120, a true quarter inch scale will have a 48 factor. Rarely does the scale 
factor created using AutoScale calculate the true, actual scale. For example, if the factor shows 479.87 
after auto-scaling and the scale on the drawing shows 1:40, selecting the 1:40 scale from the drop-down 
list will change the factor to an even 480 which is the true and proper factor for a drawing with a true 
1:40 scale. It is recommended that the calculated scale factor be compared to the factor that is generated 
by selecting the scale noted on the drawing. If the calculated scale factor is close to that factor, select 
the scale from the drop-down list. Otherwise use the calibrated scale factor. Since this autoscale factor 
is not close to any of the typical scales, click OK to accept the factor as calculated. 

Step	4	‐	Align	the	drawings	when	multiple	pages	or	files	are	opened	
 
Aligning the drawings is only required when the project contains more than one file or page. Many 
projects consist of a single PDF or DWG drawing file or page. A single file or page does not need to be 
aligned. Since this tutorial uses two (i.e. multiple) pages where the existing elevations are displayed on 
page 1 and the proposed elevations are on page 2, these pages must be aligned to each other by clicking 
the Align Dwg. command.  
 

 
 
To define the alignment points, first select the first drawing opened, which is known as the base 
drawing, and click the Align Dwg command on the Alignment section of the toolbar at the Drawings 
tab. When the drawing appears, click on two common alignment points. For this tutorial, move to the 
top left corner of the drawing and single click the corner inside the conveniently placed A circle. Next, 
move to the bottom right corner and click inside the B circle. After clicking the two alignment points, 
move to the Align section of the toolbar and click the green checkmark OK button. The alignment 
points are displayed overtop of the drawing at the Drawings tab. The red mark reveals the first 
alignment point, the blue mark shows the second alignment point. After page 1 is aligned, change to 
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page 2 by clicking Active Drawing on the Drawing section of the toolbar, click Align Dwg. and align 
page 2 to page 1 by clicking on the same two alignment points in the same manner.  
 
Alignment points should generally be the top left and bottom right of an identifiable object. In this 
tutorial, the alignment points are conveniently noted as A and B. Sometimes alignment points are not as 
obvious as this tutorial. For other projects, the top left and bottom right corners of a slab, parking area or 
property limits may be ideal alignment points. The alignment points must be common on all of the 
drawing files or pages. Each project has unique alignment point locations that must be digitized 
whenever a project uses multiple files or pages.  
 
Alignment points are required when there are multiple drawings with the same footprint. Sometimes 
multiple files/pages will display a match line with different footprints. For drawings with match lines, 
there are as many commercially available software products that stich together multiple pages along the 
match lines to create one large stitched together file.   
 

Step	5	–	Defining	Control	Points	for	Importing	or	Exporting	Elevations	
 
Setting control points are not required and will not be input for this tutorial. However, if two control 
points are recorded to the drawing file at the Import/Export section of the Drawing toolbar, GPS 
information can be imported or exported for machine control. Control points are used to link the 
drawing file to real world GPS coordinates when exporting surface model points for machine control, 
exporting the takeoff as a DWG file or importing GPS points from a CSV file. 
 
Preferably, two control points are defined. The points define the scaling and rotation information 
necessary for the export/import. If only one control point is available, the North/South direction must be 
defined. For each control point, the northing and easting distances from the origination point are 
entered. Negative northing and easting values indicate a position due south and west of the origin, 
respectively. 
 

Step	6	–	Save	the	File	
 
When done scaling and aligning the drawings at the Drawings tab, save the file by clicking the File | 
Save Project command. Please note that changes to the project file are not automatically recorded. Like 
Excel, data is initially stored in memory until the changes are saved to the drive or cloud. As a result, it 
is a good idea to save the project file frequently. 
 
Please note that a backup file is created when saving the project. This backup file will be located in the 
same folder as the original project file. The original SiteWorx/OS project file has a .ves extension. The 
backup file will have the same name with a .~ves extension.  When using the Windows File Explorer 
application (access File Explorer by right clicking on the Windows Start button) ensure that File name 
extensions checkbox is checked under the View menu. To use the backup, you’ll need to rename the 
backup file. To rename the backup file, right click on the file in File Explorer, select Rename where 
you’ll modify the file name and delete the “~” character in the file extension. After renaming the backup 
file, you can then open this backup file in SiteWorx/OS if needed. 
 
 

F. Takeoff	Tab	

 
The Takeoff tab is where the data from the drawing files are input into SiteWorx/OS. When building 
the project file, the majority of time is spent at this Takeoff tab.  
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Step	7	–	Understand	the	Takeoff	Tab	Toolbar	
 

 

Understanding how the takeoff toolbar works is critical. The sections of the toolbar are discussed 
moving from left to right. The various section names: Select, Takeoff, Display, Elevation, Action, 
Zoom/Pan, Vector PDF, and Menus are noted at the very bottom of the toolbar. 
 
 
Select 
 
The left side of the toolbar is where you change and select the Active Drawing from the list when using 
more than one file or page.  
 
The button underneath the Active Drawing button with the drop-down arrow displays a list of takeoffs 
available for selection. Initially, Project Boundary displays since the boundary is always taken off first.  
 

 
 
The takeoff process involves selecting the item to takeoff from the list and then recording the relevant 
data from the drawing file pertaining to the selection.  
 
Takeoff 
 
After selecting the object from the list, move to the right along the toolbar and select the Takeoff type. 
The takeoff type will be Include or Exclude for regions (a region is a project boundary, topsoil strip or 
topsoil respread area). The Takeoff for all other objects will be either Existing or Proposed.  
 
Display 
 
Whatever is selected as the Takeoff to the left, the Display section of the toolbar provides the option to 
display only the selected takeoff type noted to the left or both takeoff types. When Both are selected for 
elevation items, the screen will display the existing and proposed elevations for the object at the same 
time. If a region object is selected (i.e. topsoil strip, topsoil respread or project boundary), Both displays 
the included and excluded regions. The Project Boundary is always displayed for all selections. 
  
Elevation 
 
When digitizing contour lines, the elevation must be input on the toolbar whenever the Options menu | 
Show Properties/Elevation Dialog command is turned off. Normally the Options menu | Show 
Properties/Elevation Dialog command is turned on (i.e. checked) for everything except contour lines. 
If the Show Properties/Elevation Dialog is turned off for contour lines, please make sure this 
command under the Options menu is turned back on when digitizing areas, points or anything else.  
 
Next to the elevation box, a step value is entered and usually has a value of 1. Instead of typing in the 
elevation for each contour line, it is quicker to increase and decrease the elevation by the step value. 
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When clicking the increase or decrease elevation command from the right mouse popup menu or by 
using the keyboard shortcut keys (F11 keyboard key is set to decrease elevation by the step value and 
the F12 keyboard key increases the elevation by the step value), the contour line ends and the elevation 
changes by the value in the step box.  
 
Action 
 
Action tools on the toolbar are important.  
 

  Start Takeoff must be clicked to digitize items. The mouse will change from a typical mouse 
pointer to one of the following: 
 

   This mouse pointer is used to digitize pixels on screen and is the typical method to 
record items from a raster file. This mouse pointer displays when working with raster files and 
both Auto Trace and Easy Trace are turned off. When working with Vector or CAD files, this 
cross-hair displays when the Select Entity and Snap to Entity Point commands are off.  
 

 When working with vector files, the mouse pointer changes to a small selection box 
when Snap to Entity Point or Select Entity is turned on at the Vector PDF or CAD section of 
the Takeoff tab toolbar.  
 

 The mouse pointer changes to this shape when Auto Trace is turned on under the 
Raster/PDF menu. Auto Trace is available only for raster type files and is not available with 
vector type files. Prior to using Auto Trace, the background color must be defined by clicking 
on the drawing background after selecting the Raster/PDF | Background Color command. 
Auto Trace may be useful when recording contour lines from raster type files. Auto Trace draws 
the line by clicking on three points along the contour line (start of line point, direction indicator 
point along the line which is around 1” from the start of the line point and end of line point). 
Auto trace may not work when there are many intersecting lines along the contour line however. 
If it works, great. If not, don’t use it. 
 

 The mouse pointer changes to this shape when Easy Trace under the Raster/PDF 
menu is turned on. Easy Trace is a simplified way of tracing lines from raster files. When 
approaching an intersecting line using Easy Trace, simply click over the line. To use Easy 
Trace, the background color must be defined by clicking on the drawing background after 
selecting the Raster/PDF | Background Color command. 
 
 

  Stop Takeoff. When the Start Takeoff action is on, this button stops the takeoff and returns the 
pointer to mouse mode. The project can’t be saved if Start Takeoff is activated. As a result, click this 
Stop Takeoff command to save the file.  
 
 

 Delete last point. If a mistake is made when digitizing, this button deletes one point with each 
click. Clicking this button ten times in a row deletes the last ten points. Pressing the Alt + Backspace 
keys on the keyboard also deletes the last point.   
 
 

 Select an Object. To select an object for modification or deletion, click Select an Object from 
the Action section of the toolbar and move the square mouse pointer over an actual point in the object. 
The object changes color whenever the square mouse pointer is over a point. When the object changes 
color, left click on the point to select the object. For lines, a point is always found at the beginning and 
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end of the line. There may be no points in the middle of the line, the ends of the line always contain a 
point. For areas or regions, a point is always found on a corner. This command can also be activated by 
clicking the right mouse button.  
 
After selecting, the chosen item’s properties are deleted or changed on the far-right side of the window. 
After editing a selection on the right side of the window, click the green checkmark  on the top right 
side of the window to record the changes. Clicking the second red X , located to the immediate right 
of the green checkmark, deletes the object. Important: The far-right side of the SiteWorx/OS Takeoff 
window is only used to delete or change the selected object. 
 
Zoom/Pan 
 

 
 
 

 Zoom to selection zooms and enlarges the selected area. After clicking, hold down the left 
mouse button to zoom over a selected rectangle.  
  

 This command activates the zoom commands. After clicking this command, left click the mouse 
to zoom in, right click the mouse to zoom out. Click this tool again to turn off zooming. Zooming is 
quicker using the scroll wheel on the mouse or by holding down the Shift key on the keyboard while 
clicking.  
 

 Pan enables movement around the drawing. The mouse pointer will change to a hand after 
selecting this tool. Once this tool is activated, click it again to turn off panning. Panning is faster by 
holding down the Ctrl key on the keyboard while dragging and dropping the mouse with the left mouse 
button depressed. Holding down the scroll wheel on the mouse also pans the drawing.  
 

  Fit Project in Window will resize the drawing so that the Project Boundary fits inside the 
window. A Project Boundary must be defined for this command to work.  
 

 Fit Drawing in Window will fit the entire drawing inside the window.  
 
 
Vector PDF Section of Takeoff Toolbar 
 
The Vector PDF section of the toolbar displays whenever a vector PDF file is open. This Vector PDF 
toolbar section will not display when working with any other file type that is not a vector PDF. 
Remember, not all PDF files are vector, some PDF files are raster drawings. A menu with similar 
commands, entitled Vector PDF, is also added to the Menus section of the toolbar.  
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The buttons found on the Vector PDF toolbar section include: 
 

 Display the Layer List button shows the vector file layers on the left side of the screen.  
 

 Display Layer Dialog presents a pop-up window of the layers. This dialog is not needed when 
the Layer List is displayed.  
 

 Select Layers is used to identify and isolate a layer from the PDF file. After clicking on the 
Select Layers button move the red, square selection box over an object/entity point and once the entity 
is highlighted, click the right mouse button to display the popup menu.  
 

 
 
Here you can Hide Other Layers except the selected layer. Layers may be added to a display list that 
contains several layers. Layers can also be isolated from the layer list presented on the left side of the 
screen when the Display Layer List command is depressed on the toolbar. Please note - that after using 
the select layer command, you must turn off this Select Layers command on the toolbar before 
digitizing.  
 
When working with vector PDF files, the user has three options in how the items are taken off from 
vector PDF files: 1) digitize pixels on screen like a raster file by turning off Select Entity and Snap to 
Entity Point 2) Select Entity or 3) Snap to Entity Point. 
 

 Select Entity should be turned on when working with contour lines. When clicking on the line, 
the entire polyline will be selected when Select Entity is depressed.  
 

 Snap to Entity Point snaps to a single point within the entity/object. Snap to Entity Point is 
ideal for digitizing areas or dashed contour lines that contain many segmented lines. When Select 
Entity and Snap to Entity Point are both turned off, the items on the screen are digitized just like any 
other raster file.  
 

  Enable/Disable PDF Append is useful when digitizing dashed contour lines that consist of 
individual lines instead of a polyline. After selecting this command with Select Entity or Snap to 
Entity Point turned on, click along the dashed contour line to append the many dashed lines as a single 
contour line  

 
CAD Section of Takeoff Toolbar when CAD, Vector files are opened 

 
The CAD section of the toolbar displays whenever a Computer Aided Design (CAD), vector type file is 
opened. CAD file extensions include DWG, DWF and DXF. With AutoCAD files, a CAD menu is also 
added to the Menus section of the toolbar.  
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The commands found on the CAD section of the toolbar are similar to the Vector PDF toolbar commands 
noted above except an additional command is found on the CAD toolbar that imports the select layer 
information into the takeoff.  This import from drawing into takeoff command is extremely valuable 
when working with AutoCAD DWG files and is covered in the chapter entitled “Importing objects and 
elevations from DWG files”. 
 
Raster/PDF Section of Takeoff Toolbar when raster files are opened 
 

 
 
Three commands are found on the Raster/PDF toolbar: 1) Enable Auto Trace 2) Enable Easy Trace 
and 3) Select Background Color. These commands may be useful, or not, when taking off contour lines 
from raster type files. With auto trace and easy trace, SiteWorx/OS looks for the contrast between the line 
color and the background color. As a result, the background color must be defined before using Auto 
Trace or Easy Trace. Once the background color is defined by clicking on the background of the drawing, 
Auto Trace takes off the whole line with three clicks: 1) start of the line 2) an inch away along the line to 
define the initial direction of the line and 3) end of line. 
 
Easy Trace, on the other hand, matches the digitized line to the plan by dragging the mouse near the line 
with the left mouse button held down.  
 
Menus 

 
Seven menus are available on the right-side Menus section of the Takeoff tab toolbar: Takeoff, View, 
Reports, Help, Checking and Options. Additionally, one of three file type menus will be added. A 
Vector PDF menu is added when a vector PDF file is opened. A CAD menu is added and available 
whenever a vector, type computer aided design file is opened such as AutoCAD DWG. And finally, a 
Raster/PDF menu is available when the file opened is a PDF type raster file or another type of raster 
file. As noted previously, click the F1 keyboard key or click the Help button  in the top right-hand 
corner of the window and then click on the menu with the question mark mouse pointer to learn about 
the various sub-menus.  
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Step	8	‐	Digitize	the	Project	Boundary	

 
 
The project boundary must be digitized before anything else. Please note: 
 

 Ensure that Page 2, which displays the proposed elevations, is the Active Drawing in the Select 
section of the toolbar. Note: the project boundary should always be digitized from the drawing 
file that shows the proposed contour lines. Project Boundary should be chosen from the Select 
list box found underneath the Active Drawing button. Next, click on Include at the Takeoff 
section of the toolbar which is to the immediate right of the Project Boundary selection. The cut 
and fill volumes are limited to the Include region.  

  
Please note: although there are no excluded project boundaries in this tutorial, SiteWorx/OS can 
exclude certain regions from the included project boundary by selecting Exclude and then 
digitizing the excluded region inside a previously digitized Included Project Boundary. Excluded 
regions must be contained within included regions and must be digitized after the included 
Project Boundary is recorded.  
 

 The Project Boundary is where the cuts and fills are calculated. Inside the project boundary 
existing elevations should be different from the proposed elevations. Again, no cuts and fills are 
calculated outside the included project boundary. When digitizing the project boundary that is 
not defined with clear boundary lines, click on the end of each proposed contour line which 
should be where the proposed contour meets up with the existing contour line. 

  
 The included project boundary is the region where the proposed elevations are different than the 

existing elevations. Again, the project boundary is normally defined on the file or page that 
contains the proposed elevations (i.e. page 2 in this tutorial).  

 

 To digitize the project boundary, click the lightning bolt Start Takeoff button  
located at the Action section of the toolbar. The mouse pointer will change to a cursor 
crosshair when Select Entity and Snap to Entity Point are not depressed on the Vector 
PDF section of the toolbar. When digitizing the project boundary, do not depress Select 
Entity or Snap to Entity Point. 

 
 In this example, click on any corner of the blue project boundary line. A Region 

Properties dialog box will display after clicking the first point where information about 
the project boundary is entered. At the dialog box, change the line width to 3 and click 
the OK button. Please note, this dialog box displays only when Show 
Properties/Elevations dialog is checked under the Options menu on the toolbar. After 
clicking the first corner, click on each change of direction (i.e. corners) while moving 
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around the project boundary either clockwise or counterclockwise. Do not trace the 
boundary line. 

  
 To digitize around a curve, simply click in small increments around the curve or, better yet, 

press the right mouse button and select the Arc command followed by a click along the curve 
and another click at the end of the curved line. The Arc command is also quickly activated by 
the keyboard shortcut of Alt+A. In summary, after digitizing one point, activate the Arc 
command by the keyboard shortcut keys Alt+A, and then click on two points around the curve 
to draw a curved line. 

 
 When done digitizing the last corner of the project boundary, press the right mouse button Stop 

Takeoff command. This boundary will close back to the first point digitized and the mouse 
pointer will change to a typical mouse pointer.  

 
 After stopping the takeoff, information about the project boundary is found on the right side of 

the screen. 
  

 After digitizing the project boundary, it is a good idea to verify that the project boundary is 
properly placed over all the drawing files to make sure your alignment points were properly 
recorded per Step 4 above. Change the drawing by clicking on the Active Drawing selection 
on the toolbar to verify that the boundary is properly located on each file or page. 

 
 The Align Grid button at the Grid section of the toolbar is not used with this tutorial. 

Information about this command is available clicking F1 Help. However, for future knowledge and 
use, the Align Grid button aligns the grid to a side of the project boundary or to a selected 
point. The Align Grid command is only available for the first drawing opened (i.e. the base 
drawing). Aligning the grid may be required when exporting stake or GPS data. If the grid is 
not shown overtop the drawing, click on the View menu | Takeoff Grid to display. The grid 
size spacing is set at the Calculations tab. After clicking the Align Grid button, the project 
boundary can be aligned with the grid lines or to a selected point, such as a slab corner. If 
aligning the grid to a point, make sure the desired point has been recorded as a Point 
Elevation at the Select section of the Takeoff tab toolbar. Then at the Point Elevation 
window select the desired point using the Select an Object tool from the toolbar . After 
selecting the point, select the Project Boundary and press the Align Grid button to align the 
grid to this selected point.  

 

Step	9	‐	Digitize	Contour	Lines		
 
After digitizing the Project Boundary on page 2, change the active drawing to page 1, select Contour 
Line from the Select drop down list. The existing contour lines on page 1 and the project boundary 
should now display.  
 
Before digitizing contour lines, click on the Options menu and make sure the Show 
Properties/Elevation dialog is unchecked and turned off (this command should be turned on for 
everything but contour lines). Next, select Existing as the Takeoff and type in 98 in the 
Elevation box with a Step value of 1. The Display section of the toolbar should be set to Takeoff, 
not Both.  

 
When working with a vector file, the contour lines can be taken off in three different ways:  
 

1) Click along the line with the mouse by clicking on the change in direction inflection 
points. Select Entity and Snap to Entity Point must be disabled on the Vector PDF 
section of the toolbar. 
 

2) Use the Select Entity tool where the contour line from a vector file is taken off with a 
single click. The Enable PDF Append command is also useful with Select Entity 
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when taking off dashed contour lines. 
 

3) The Snap to Entity Point tool may be used with the Enable PDF Append 
command to connect multiple lines contained in a dashed contour line. In this 
tutorial, this command will not be used since the contour lines are polylines. not 
segmented lines. 
 

This tutorial will demonstrate all of the methods noted above. Item 1) above is how items are 
digitized from raster files. When performing the takeoff, you’ll determine which method is best for 
the specific drawing file. The Select Entity and Snap to Entity Point commands are only available 
if the drawing is a vector type. On many projects, using more than one method is common.  
 
Method 1 – Click on the change of direction on the contour line 

 
First, using method 1 noted above, please ensure that the Select Entity and Snap to Entity Point 
buttons are not on or depressed at the Vector PDF section of the toolbar. Also, the Elevation 
should be at 98, Step should be 1 at the Elevation section of the toolbar and the first command 
under the Options menu should be unchecked or turned off. Next click the  Start Takeoff 
button on the Action section of the toolbar to begin digitizing on the end of the contour line.  

 
Since the contour lines are changing in foot increments, it is quicker to change the elevations by using 
the step value defined on the toolbar rather than typing the elevation for each line. Click on the change 
of direction along the 98-foot contour located at the bottom right corner of the drawing and when done 
digitizing along the 98 line, increase the elevation value by pressing the F12 keyboard shortcut key. 
Elevations are decreased by the step value by pressing the F11 keyboard shortcut key. Whenever the 
elevation is changed the line will end. Next, click on the beginning of the 99-elevation contour line and 
click along the line and repeat the above same steps.  

 
Practice digitizing the contour lines using method 1 from the bottom right corner up to the 102-
elevation line while using the right mouse button or F12 and F11 keyboard keys to increase and 
decrease the elevations by the step value.  
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Please remember, zooming is best done using the scroll wheel on the mouse and moving around the 
drawing (i.e. panning) is performed by holding the keyboard Ctrl key while dragging the mouse. 
Practice moving around, panning, changing elevations and recording contour lines.  

 
If you digitize incorrect points, click the Delete last point button on the Action section of the toolbar 
or press the Alt+Backspace keyboard shortcut keys. To end one line and start a new line with the 
same elevation, right click the mouse and select New Object from the popup menu. After digitizing 
the 102-contour line, right click the mouse and select Stop Takeoff or click the red X  in the 
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Action section of the toolbar.  
 
The properties for the last item digitized are shown on the right side of the window. Here the elevation 
and/or other properties can be changed or the entire line can be deleted. To record any changes made on 
the right side of the window, click the green checkmark on the top right side of the window  to record 
the change(s). To select a contour line for modification or deletion, click on the Select Object tool  
from the Action section of the toolbar and move the square selection box over a point within the line 
(please note that points are always found at the beginning and end of every contour line) and when the 
line is highlighted, left click to select that line. To delete the selected line that is now displayed on the 
right side of the window, click the red X button  located to the right of the green checkmark on right 
side of the window.  
 
  
Method 2 – Select Entity 
 
The remainder of the existing contour lines will be digitized using the Select Entity feature as noted in 
method 2) listed previously. Now that some of the existing contour lines have been recorded using the 
raster file takeoff method, the remaining contour lines will use the select entity, vector file method.  
 
To digitize the proposed contour lines with the Select Entity setting, insure Select Entity  is clicked 
on the Vector PDF section of the toolbar. Finally, change the elevation at the Elevation section of the 
toolbar to 103 and make sure the Step value is set to 1. Now click Start Takeoff on the Action section 
of the toolbar to begin.  
 
The mouse pointer will display a box when Select Entity is turned on. Move the selection box over a 
point in the 103’ contour line and left click on the line to takeoff the entire line. When done, use the 
F11 keyboard key to decrease the elevation by the step value to 102’. Click the 102’ contour line to 
takeoff the entire line. Continue to increase or decrease the elevations using the F12 and F11 keyboard 
shortcut keys or the right mouse button popup menu and then click on the line. Using Select Entity for 
contour lines from vector PDF files demonstrates the superiority of vector files over raster files when 
performing the takeoff. 
 
When done with all of the existing contour lines, click Stop Takeoff from the right mouse button 
popup menu or from the Action section of the toolbar and then change the Active Drawing to Page 2 
to digitize the proposed contours. Remember the Takeoff should be changed to Proposed on the 
toolbar ribbon before digitizing the proposed contours. 
 
Before digitizing the proposed contours, lets isolate the proposed contour lines and elevations layers 
from the page 2 vector PDF file by performing the following: 
 
a) Make sure the layer list is displayed on the left side of the window . If not, depress the Display 

Layer List command at the Vector PDF section of the toolbar. 
b) Next, click the Select Layers command from the Vector PDF section of the toolbar . 
c) Move the square selection box over the end of a red proposed contour line. 
d) When the contour line is highlighted, right click the mouse and select Hide Other Layers. 
e) Display the proposed elevations by moving over to the layer list on the left side of the window and 

click the light bulb to display the DESIGN_LABELS layer. 
f) Turn off this select layers command by clicking on the Select layers command again before 

digitizing.  
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Like the existing contour lines, simply set the elevation and then click on a point in the proposed 
contour line to takeoff the entire line. When done with the contour lines, turn on all layers by clicking 
the yellow lightbulb at the very top of the layers list on the left side of the window. 
 
Method 3 – Snap to Entity Point 
 
When taking off contour lines from vector files, Select Entity is usually the preferred method. 
Sometimes however, the drawing has a collection of lines along the contour line rather than a single 
polyline. If you come upon a contour line that contains many small lines or entities, change from 
Select Entity to Snap to Entity Point on the Vector PDF section of the toolbar. Additionally, the 
PDF Append Mode should be turned on when digitizing contour line segments. 
 
Snap to Entity Point is also the preferred method to takeoff areas from vector files. This Snap to 
Entity Point takeoff method will be demonstrated when recording the proposed areas.  
 

Step	10	–	Digitize	Point	Elevations		
 
Page 2 on the Active Drawing contains point elevations. After digitizing the proposed contour lines, 
select Point Elevation from the Select section of the Takeoff tab toolbar. Click Proposed as the 
Takeoff type. Turn off Select Entity and Snap to Entity Point on the Vector PDF section of the 
toolbar. When taking off points, turn on at the Options menu | Show Properties/Elevation Dialog.  
Finally, click the Start Takeoff button to begin digitizing.  
 
The 103.23 point elevation is located in the top left corner of the window below the A circle. Simply 
click on the point and then enter the elevation followed by the Enter key on the keyboard. Using the 
number keyboard, rather than the mouse, to record elevations into the Properties/Elevation Dialog will 
increase your data entry speed. Digitize the top of curb elevation points around the parking lot. When 
done digitizing all of the point elevations, click the right mouse button Stop Takeoff command to 
return to mouse mode.  
 

Step	11	‐	Record	Sloping	Design	Lines	
 
A design line is a sloping line where the end points will have different elevations. Between the end 
points, a series of increasing or decreasing elevation points are created along the design line. Points 
found in contour lines and point elevations that are closest to the design line will connect to the points 
created along the design line.  
 
On many projects, design lines are not needed since the contour lines and point elevations will properly 
model the surface. Users should determine if design lines are needed in certain locations only after 
looking at the 3D model noted at the 3D View tab. 
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In this tutorial, after looking at the 3D View, design lines are used to define the slope of the parking lot. 
When recording a Design Line, the Show Properties/Elevation Dialog under the Options menu should 
be turned on. After selecting Design Line and Proposed Takeoff from the Takeoff tab toolbar, click the 
Start Takeoff button and after clicking on the end point of the line, type in the elevation and press the Enter 
key on the keyboard. Click on the other end point of the line and enter a different elevation followed by the 
Enter keyboard key. All points generated along the design line will have different elevations that will slope. 
Design lines should not cross.  
 

 
 
 
When recording design lines with the Options | Show Properties/Elevation Dialog checked, the 
elevation of the points contained in a design line may be calculated based on a slope by checking the 
Pitched check box. After clicking the Pitched check box, enter either a rise and run value or a 
percentage. For lines the slope downwards, the slope % or rise value will be negative. This tool is 
helpful in determining the end point elevations of a line with a constant slope.  
 
After entering points from contour lines, point elevations and sloping design lines, the points connect 
to each other in all directions to create a 3D surface model. Proposed points do not extend outside the 
project boundary. If there is only one proposed point, the entire proposed site will be flat at the 
elevation of that one point.  
 

Step	12	–	Record	Areas	
With SiteWorx/OS, the existing and proposed surface models are initially created by connecting the 
individual points to each other in all directions. Any point located in a contour line, design line or 
point elevation will connect to the next closest point in all directions. The surface model is initially 
created by connecting elevation points. After the 3D surface model is created by connecting points, 
the areas are then placed overtop of the surface model as a geometric plane. 
 
Please note there are four area types: Surface, Basement, Subgrade Only and Other. Before 
digitizing an area from the plan, please determine the area type.  
 

1. A Surface area, such as a building slab, is for flat areas that are near grade at a 
specified elevation.  
 

2. A Basement area type is for flat areas below grade. Surface and Basement areas are 
the same except that a contour line is drawn around the perimeter of a Surface area 
where the elevation points from the contour line will slope to the closest elevation 
points outside of the Surface area. A Basement area, on the other hand, will be 
dropped down to the specified elevation, and the walls will be straight up. The 
perimeter of a Basement does not slope or connect to the closest elevation points like 
a Surface area.  

 



22  

3. A Subgrade Only area is used for non-flat areas, such as parking lots and sidewalks. 
The elevations over a Subgrade Only area will be reduced by the subgrade layer 
depths that are entered. The elevations of a Subgrade Only area, before being 
reduced by the layer depths, are initially determined by the elevation points (i.e. 
contour lines, point elevations or design lines) previously entered.  
 

4. An Other area type is used to calculate areas, perimeters and layer volumes. Other 
areas have NO effect on the 3D model or the cut and fill volumes. Other is used for 
measuring only.  

 
Again, before digitizing the area, determine the type of area being taken off. Is it a Surface Area or 
a Subgrade Only area? Again, flat slab areas are Surface areas, flat areas below grade are 
Basement areas and non-flat areas are usually Subgrade Only areas. When digitizing areas, the 
Show Properties/Elevation Dialog should always be checked under the Options menu.  
 
Digitizing a Flat Surface Area 
 
Select Page 2 as the Active Drawing on the Select section of the Takeoff tab toolbar to display the 
proposed elevations drawing file.  
 
Isolating design layers from vector files eliminates drawing information that is not needed or 
relevant to the current takeoff. Again, isolating drawing layers is a key advantage of vector files. To 
isolate a vector layer (e.g. the slab on grade) please insure that Display the Layer List is turned on 
at the Vector PDF toolbar. The width of the layer list on the left side of the window is adjusted by 
moving the mouse pointer to the edge of the list and once the pointer changes to a double headed 
arrow, drag the edge of the layer list window to resize.  
 
Click the Select layers button on the Vector PDF toolbar and then move the red square mouse 
pointer over a corner of the building slab. When the perimeter line is highlighted, right click the 
mouse to obtain a popup menu of layer commands.  
 

 
 
To display the selected layer only, select the Hide Other Layers command from the popup menu.  
 
Please note that several layers could be added to a display list by clicking on the Add Layer to 
Display List command. After the desired layers have been added to the Display List, click Show 
Display List to show this collection of layers. The created display list is used when you want to 
show two or more layers at the same time. For example, a display list could be created for the 
proposed slab, parking lot and annotations.  
 
After the building slab displays, move to the layer list on the left side of the window and turn on, by 
clicking, the light bulb for Slab Annotation, Pkg lot and parking Lot Annotation layers. Four 
layers should now be displayed. Please note, the yellow light bulb on the top of the left side layer 
list displays all of the layers. The white light bulb at the top, turns off all layers.  
 
Important - When done selecting the desired layers, turn off the Select Layers command on the 
Vector PDF section of the toolbar and click on the Snap to Entity Point command. This area 
takeoff will demonstrate how the Snap to Entity Point method works with a vector file.  
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To digitize areas, select Area Elevation from the Select section of the toolbar at the Takeoff tab. 
Next, select Proposed as the Takeoff. Click Start Takeoff on the Action section of the toolbar and 
then click the first corner of the slab to display the Area Elevation Dialog.  
 
At the Area Elevation Dialog type in 107.33 as the proposed finish floor elevation, click proposed 
and select Surface as the Area Type, enter 4 as the Overcut length in feet, enter .33 as the Above 
Grade value, change the color and fill pattern, and finally, Name the area as “Slab on Grade FFE 
107.33” and then click OK.  
 

 
 
To digitize the building area, click on four corners, which will snap to the corner point, either clockwise 
or counter clockwise around the slab, and then press the right mouse button and select Stop Takeoff to 
complete. There is no need to digitize back to the first point. When stopping the area takeoff, the area 
will automatically close to the first point.  
 

 
 
Any of the information improperly recorded at the Area Elevation dialog may be changed on the right 
side after the area is completed. To save any changes made on the right side, click the green 
checkmark  found on the top right-hand side of the window. The entire area can be deleted by 
clicking the  to the right of the green checkmark. 
 
The material subgrade layers under the slab are input by clicking the Layers tab on the right side of the 
window.  
 
Click the Layers tab and create two layers: Concrete and Select Fill should be typed in the Material 
boxes. The depth of the concrete should be .5 and the depth of the select fill should be 2 feet. The select 
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fill should also be applied to the overcut area by checking the Include Overcut box by scrolling to the 
right side of the layers list. 
 
  

 
 
 
Please note the following regarding the Layers tab: 
 

 The width of window is changed by moving the mouse pointer to the left edge of the 
window near the up and down scroll bar. Once the pointer changes to a double headed 
arrow, drag and drop the window width.  

 
 To add, delete and record layers, use the buttons at the bottom. Moving, up or down, off 

the layer record also records any changes. 
 

 If the layers are spelled consistently, the layers for all of the areas will be totaled under the 
Reports | Material Volumes … menu.  

 
 If an area has on overcut value greater than 0 at the Properties window, the material layer 

can be applied to the larger overcut area by checking the Include Overcut checkbox. When 
Include Overcut is checked, the volume of backfill is also calculated.  

 
 The layer and backfill volumes are not included in the fill volumes shown at the 

Calculations tab.  
 

 The Reports | Area | Layers report discloses the layer volumes that need to be added to the 
site.  

 
 Layer details may be copied from the last area digitized by clicking on the Options menu | 

Copy Area Layer Info | Always.  
 

 
Digitizing a Non-Flat Subgrade Only Parking Area 
 
To digitize a non-flat area, such as the parking lot or sidewalk, select Area Elevation from the 
drop-down list box at the top of the Takeoff window. Next, select Proposed as the Takeoff, click 
the Start Takeoff command from the Action section of the toolbar, and click the first corner of the 
parking lot to display the Area Elevation Properties dialog box. If SiteWorx/OS asks about 
copying the layers from the last area, click No. 
 
When recording non-flat areas like parking lots or sidewalks, the elevation of the digitized area will 
be reduced by the subgrade layers depth. As a result, elevations are not needed or used for 
Subgrade Only areas. At the Area Elevation Properties dialog box ignore the elevation box and 
change the proposed Area Type to Subgrade Only, change the color, fill pattern and name the 
area as “Parking Lot”.  
 
Simply click on the change in direction as you move clockwise or counterclockwise around the 
parking lot. Click in small increments around the curve at the bottom of the parking lot or input the 
curved line using the Arc command. To activate the Arc command, right click the mouse and select 
Arc or press Alt+A shortcut keyboard keys. After activating the Arc command, click anywhere along 
the curve followed by a click on the end of the curve. To correct a mistake, click the delete last point 
command from the Actions section of the toolbar or press the keyboard Alt+Backspace keys (twice 
for arcs). When done digitizing the parking lot, click the Stop Takeoff command to complete.  
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Please note the following about Subgrade Only areas: 
 

 If changes need to be made, select the area and change any of the information on the right side. 
After changing information on the right side click the green checkmark at the top right  to 
record the changes.  

 
 Click the Layers tab on the far right to enter the layers. Since the elevation points inside this 

area were recorded at the top of curb elevations, a layer is required for the height of the curb of 
.5 feet to bring the elevations down to the top of pavement. Another layer will be added for the 
2” Asphalt (.17 depth in feet) and a third layer of .33 depth in feet for the 4” Type II base. 
When done with the layers, click the checkmark at the bottom of the layers window to record 
the changes. With three layers that are a total of 1 foot deep, the proposed subgrade elevations 
previously digitized will be reduced by 1 foot over this area.  
 

 Any negative areas (e.g. the planter island) must also be digitized. After clicking Start 
Takeoff, digitize a point on the excluded area and SiteWorx/OS will ask if you want to copy 
the layers from the parking area. Answer yes, and the properties dialog box displays. Here, 
check the Negative box on the Area Elevation Properties dialog, ensure Subgrade Only is 
the area type and click around the planter island area. When done, right click the mouse and 
select Stop Takeoff. Again, if anything was not entered properly at the Area Elevation 
Properties dialog, move to the right side after the area is completed and change the properties. 
For this negative area, click on the Layers tab on the right and make sure the layers were 
copied from the parking lot area (i.e. .5 height of curb, .17 Asphalt and .33 Type II Base). The 
layer volumes disclosed for this negative area will be subtracted from the parking lot’s layer 
volumes.  
 

 There is no demolition and removal on this project. If you encounter a job with demolition, 
removing a parking lot or sidewalk from an existing site for example, the area should be taken 
off as an Existing Subgrade Only area and a layer called “remove or demo payment” must 
be added at the Layer tab on the right with the depth of the material to be removed. The 
volume of the parking lot to be removed will be disclosed under the Reports menu | Area | 
Layers. The cuts and fills shown on the Calculations tab are the volumes after the existing 
parking lot was removed.  
 

Step	13	–	Record	Topsoil	Strip	and	Topsoil	Respread	regions	
 
If the project requires topsoil to be stripped or respread, these topsoil regions must be recorded. If 
borings are used however, the topsoil strip volume is always calculated from the boring log data and 
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you can’t digitize topsoil strip regions from the drawing. 
 
There are three ways to enter topsoil regions: 1) digitize with the mouse the topsoil region and enter 
the depth at the displayed dialog window 2) select Project Boundary from the Takeoff tab, and copy 
the entire project boundary as a topsoil region or 3) record a topsoil layer when using borings.  
 
 
In this tutorial, the project boundary will be copied as a topsoil strip and topsoil respread region. At the 
Takeoff tab Project Boundary selection, click a corner of the project boundary after clicking the 
select an object command  at the Action section of the toolbar; after selecting the project boundary, 
click the right mouse button when the mouse pointer is over the drawing and select Copy as Topsoil 
Strip. The Copy Region dialog appears.  
 
 

 
 
 
The above dialog will copy the entire project boundary as a topsoil strip area. Enter a Depth in 
decimal feet or meters (. 5 for 6 inches) with a Fwd Diag. fill pattern. When done filling out the 
dialog box, press the OK button.  
 
Then copy this same project boundary as a topsoil respread region by pressing the right mouse button 
again inside the project boundary and select Copy as Topsoil Respread. Enter a depth of .5 and click the 
OK button.  
 
The slab and parking lot previously digitized at the Area Elevation selection will be copied as 
Excluded Topsoil Respread regions as noted in Step 14 to arrive at the proper topsoil respread volumes.  
 
These copied regions may be edited at any time by selecting Topsoil Strip or Topsoil Respread from 
the Select section of the Takeoff tab toolbar.  
 

Step	14	‐	Copy	Selected	Areas	as	Excluded	Topsoil	Respread	regions	
Since topsoil is not re-spread over the building and parking lot, these areas will be copied as excluded 
topsoil re-spread regions by performing the following: 

 

 At the Takeoff tab, select Area Elevation. Click the Select an Object tool from the Action 
section of the toolbar, and left click on the corner of the slab to highlight and select.  

 After the area is selected, right click the mouse, and select Copy as Topsoil Respread.  

 A copy region dialog box is displayed. Change Include to Exclude on the dialog box, and click 
OK.  

 When done with the slab, select the parking lot and perform the same steps to exclude the 
parking lot as a topsoil respread region. 

 This excluded topsoil re-spread regions are displayed when Topsoil Respread is selected from 
the toolbar and the Display section of the toolbar is set to Both.  
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The takeoff for this limited tutorial is now complete. Calculating the results, reviewing the information 
and printing the reports will be done next. Once the review is completed, the user may need to return to 
the Takeoff tab to select certain items for modification. To record changes, select the takeoff from the 
toolbar (i.e. contour line, point elevation, etc.) then use the Select an Object tool from the Action 
section of the toolbar to select the individual item. Make changes on the right side of the window 
followed by the green checkmark to post the changes. You can also select items for editing by using the 
Checking | Examine menu from the Takeoff toolbar to scroll through all of the number objects by 
clicking on the arrows displayed on the top right side of the window.  

 

To calculate the results, click on the Calculations tab… 
 

G. 	Calculations	Tab	

	

Step	15	‐	Calculate	the	results	at	the	Calculations	tab	
 
 
Comments about the Calculations tab’s toolbar: 
 

 Click the Calculate button located at the top left of the Calculation tab toolbar to figure.  
 

 The TO Check button on the toolbar checks the takeoff for errors or for elevations that are 
outside the Min and Max Elevations specified under the Takeoff tab Checking menu.  
 

 At the very bottom of the calculated information, the site balancing adjustment is shown. If 
the proposed elevations are adjusted by this value, the site will balance where the subsoil cut 
volume will equal the fill volume and there will be little subsoil import or export. To balance 
the site which will change the proposed elevations, click the Balance button on the toolbar. 
IMPORTANT - save the project file as a different name prior to clicking the Balance button 
since the proposed elevations will change and will no longer agree to the proposed elevations 
noted on the drawing. For this tutorial, do not balance the site. 
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 The calculated information may be copied to the clipboard in order to paste this information 
into other programs such as Excel. To copy, click the Copy to Clipboard button on the 
toolbar. Many estimators use Microsoft Excel to apply costs to the quantities. Open Excel, 
click on a cell and then paste this information from the clipboard into Excel. An Excel file can 
also be created by clicking the Save as XLS…  command on the toolbar. 

 
Comments about the Calculations tab work area: 
 

 The actual grid lines based on the grid size setting are displayed at the Takeoff tab when the 
menu View | Takeoff Grid is turned on. The cut and fill volumes for each grid box are 
disclosed at the Grid Data tab. A smaller grid results in a more detailed calculation of 
volumes. Grid size also affects the resolution of the 3D image shown at the 3D View tab.  

 
 Topsoil and subsoil expansion and compression factors are recorded at the Calculations tab. 

The Site Swell factor concerns soil expansion and the Import Swell factor and the related 
Import Compression % (i.e. Imp. Comp. %) affects soil compression. The Site Swell factor is 
multiplied by the bank or tight volumes to arrive at loose cubic yards (LCY). The Import 
Swell factor is divided into the loose volumes to arrive at compressed yards. Alternatively, 
the related Imp. Comp. % adjusts the import volumes to arrive at the tight volumes. The 
Discard % for topsoil is deemed to be waste. The percentage of topsoil recorded as waste 
may be green material that dies or topsoil that disappears from the topsoil strip volumes. If you 
desire no swell or compression simply set the factors to 1. For no topsoil waste, set the 
percentage to 0.  
 

 Topsoil strip volumes are displayed at the Calculations tab only for jobs that do not use 
boring logs. If boring logs are setup at the Project tab, the topsoil strip volumes, as defined 
by the boring logs, are shown at the Reports | Cut by Soil Type menu.  

 
 The Resolution setting affects the amount of calculations that are performed for each grid 

square. Each grid is further subdivided into smaller calculation grid squares based on the 
resolution setting. The higher the resolution results in more calculations per grid square. The 
number of sub-grid squares also increases when the resolution setting is increased. The 
following are the number of squares for each grid box for the resolution settings: 

 
 Low – 100 calculation squares for each grid box (10 x 10) 
 Medium - 625 squares for each grid box (25 x 25) 
 High – 2,500 squares for grid box (50 x 50) 
 Very High – 10,000 squares for each grid box (100 x 100)  

  
The resolution setting truly affects the detail and number of calculations. As you can see, Very 
High resolution creates 100 times more detail and calculations than Low resolution.   
  
For speed and ease of use, first calculate using the Low or Medium Resolution setting. After 
calculating, review the results and look at the 3D View tab to verify the takeoff. If the 3D View 
tab and numbers look reasonable, recalculate using High or Very High resolution for final 
results. The higher the resolution, the more calculations performed in SiteWorx/OS and the 
longer it takes. If you have 100 grid boxes over the site and you calculate at very high 
resolution, the project will use one million smaller calculation squares or sub-grids to calculate 
the volumes. If the grid size is too small or the resolution is too high, the calculation time may 
be excessive. To speed up the process, increase the grid size and/or reduce the resolution 
setting.  
  
The Grid Size and Resolution interact to have an effect on the accuracy of the calculated 
volumes. Increasing Resolution decreases the size of each square calculated. With a 50' grid, 
Low Resolution calculates based on 5' X 5' squares. High Resolution calculates on 1' X 1' 
squares.  

 
 

 Calculated results are shown to the right of the screen. Information is broken out by 
topsoil and subsoil volumes. The left column displays the tight, bank volumes before 
swell factors. The right column shows the loose volumes after applying the swell factors.  

 
 Total Cut = Subsoil Cut + Topsoil Strip 

 
 Total Fill = Subsoil Fill + Topsoil Respread 

 



29 

 IMPORTANT PLEASE READ – At least one existing and proposed elevation point must 
be entered in order to properly calculate the volumes. An elevation point is either a contour 
line (a contour line generates a series of equidistant points along the line with the same 
elevation) or a point elevation. SiteWorx/OS calculates volumes and develops a 3D model of the 
existing and proposed site based on the elevation points entered. The elevations points, 
created from the contour lines, point elevations or design lines, are connected to each other to 
develop the 3D model. Areas are then placed on top of this 3D model as a geometric plane at 
the very end. SiteWorx/OS develops an existing and proposed surface model from the items 
digitized. Again, at least one existing and proposed point must be input. And areas and 
design lines don’t count.  

 
 The total cut and fill volumes are calculated based on the differences between the existing and 

proposed surface models created by the data entered. If the proposed elevation is higher than 
existing for a sub-grid square, the volume for that square is calculated as a fill volume. 
Likewise, if the proposed elevation is lower than existing elevations for a resolution grid 
square, the volume for that square is defined as a cut volume.  

 
After calculating, click on the 3D View tab to review the models… 
 

H. 	3D	View	Tab	

Step	16	–	Review	the	models	at	the	3D	View	tab	

	

	
	

 The quality and resolution of the 3D view is determined by the grid size and resolution setting 
at the Calculations tab. A smaller grid size and a higher resolution setting increases the quality 
of the 3D view. 
 

 When Manipulate section is set to none, moving the mouse pointer over the 3D model displays 
existing and proposed elevations at that location along with the cut or fill depth. 

 
 The 3D style is best for displaying the Existing and Proposed data. The Plan style is ideal 

for showing the Cut/Fill and Rock Cut data.  
 

 Display OB will show the image outside the project boundary. Existing elevations can go 
outside the project boundary. Proposed elevations stop at the boundary line.  
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 Show Mesh displays the calculation square lines. When using a high-resolution setting, the 

image may be dark due to the many squares. To improve the view, increase the size of the 
image by zooming using the manipulate commands or turn off the Show Mesh setting.  

 
 The drop-down list box in the Manipulate section of the toolbar allows the rotation and resizing 

of the 3D view. If the Rotate and Zoom manipulate option is selected, zoom the image by 
holding down the right mouse button while slowly dragging the mouse from the center. Rotate 
the image by holding down the left mouse button while slowly moving the mouse.  
 

 The Z% exaggerates the Z scale when increased. The Z% should be set to 100 or sometimes 10 
to display the 3D view to scale. To display the elevations disproportionately, increase the Z% 
value.  

 
 The reset button resets the image to the default values.  

 
 Elevation errors are clearly displayed at the 3D View tab. Important - look at the legend at the 

bottom of the screen. Are there any spikes? Is the existing or proposed site all one color and is 
the range of elevations on the bottom legend reasonable? A 0 elevation on the left side of the 
legend indicates that an item was digitized without an elevation. At the Takeoff tab, click the 
Checking | Examine menu at the Takeoff tab to find incorrect elevations.  

 

  The Rock Cut display is only available when boring logs are used and one of the soil strata 
layers is defined as a rock layer. 	

  

I. Review	and	make	adjustments	

Occasionally incorrect elevations and data may be recorded. The 3D View tab will clearly display 
problems. Does the 3D View tab show spikes? Does the range of elevations on the legend at the bottom 
of the 3D View window look correct? Does the existing, proposed and cut/fill models look reasonable? 
If any of the 3D models do not appear proper, something is wrong. If there is an error, try to determine 
if the error is due to an incorrect elevation point, contour line, area, or design line? The Review 
selection at the Takeoff tab displays the data in relationship to other selected objects.  

 

To find and correct an error, perform the following: 

i. Go the Takeoff tab, select and display any of the takeoffs (i.e. Contour Line, Point Elevation, 
Area Elevation, etc.).  

ii. If the error is obvious, click the select an object tool  on the Action section of the toolbar and 
click on a point within the object (end of contour line or corner of area) and then change the 
incorrect data on the right side followed by the green checkmark.  

iii. If the item causing the error is not obvious, look at all of the digitized objects by clicking the 
Checking | Examine menu. All objects are assigned a number with SiteWorx/OS. When 
Checking | Examine is turned on, the object’s number will be displayed on the top right side of 
the window. Browse through the numbered objects by clicking the arrow buttons to the 
immediate right of the number to find the takeoff object causing the problem.  

iv. At the Takeoff tab, after clicking on Checking | Examine, click Checking | Above Maximum 
and Below Minimum to find items that are above or below the max and min elevation settings 
you define. The min and max settings are set at the Checking menu | Min or Max Elevation.  

v. After selecting the object, the right side of the window will display the properties of the selected 
object which may be changed and deleted. Again, click the  green checkmark to save 
changes.  

vi. To delete an object, click the  Delete selected object tool located on the right side of the 
window and to the right of the  green checkmark.  

vii. The width of the properties window on the right side may be resized by holding down the left 
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mouse button while dragging the mouse once the mouse pointer changes to a double headed 
arrow.  

viii. When reviewing the objects, please make sure the elevations are accurate, the takeoff type is 
correct (i.e. existing or proposed) and the areas are properly defined. Areas that are not flat are 
normally Subgrade Only areas; flat areas are either Surface or Basement areas. When looking 
at Surface and Basement Area Elevation objects, the actual elevations are shown at the 
Corners tab. Also, make sure the subgrade material depths are properly recorded at the Layers 
tab for each area.  

 

After making the changes, save the file and look at the effects at the 3D View tab.   
 

J. 	Cross	Sections	Tab	

 

	
 

The project boundary with the grid lines are displayed on the left side of the Cross Sections tab. As 
noted previously, the grid spacing is set at the Calculations tab. The top left side of the Cross 
Sections toolbar, has three Selections: Grid, Line and Trench.  

 

 
 

When Grid is selected, the horizontal and vertical cross sections are displayed along the grid lines 
by clicking anywhere inside the grid box. The top right image shows the location of the cross-
section line running from left to right along the grid. The bottom right image displays the vertical 
cross-section line from bottom to top.  

 

With Version 10 of SiteWorx/OS, users can now create and name cross section lines anywhere by 
creating the line at the Cross Section Line selection of the Takeoff tab. Once custom lines are 
created at the Takeoff tab, these custom cross sections will display by selecting Line from the Cross 
Sections toolbar and then selecting the previously digitized cross section line from the list. 

 

Cross sections along the digitized trenches are now available with version 10. Whenever trenches 
are digitized at the Takeoff tab, the cross section of the trench displays when Trench is selected at 
the top left corner of the Cross Sections tab toolbar. 
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K. 	Grid	Data	Tab	

To the right of the Cross Sections tab is the Grid Data tab.  
 

 
 
 
The cut and fill volumes for each grid are shown at the Grid Data tab. The actual grid is displayed 
overtop the drawing file at the Takeoff tab. If the grid does not display at the Takeoff tab, click on the 
View | Takeoff Grid menu to display. And remember, the grid size is set at the Calculations tab.  

 
The Cut/Fill display is shown above. The Cut and Fill volumes consists of the topsoil volumes and the 
subsoil volumes. Like the calculations window, Total Cut equals Topsoil Strip plus Subsoil Cut and 
Total Fill equals Topsoil Respread plus Subsoil Fill. The stake height adjustments for each of the 
four corners of the grid may be before or after topsoil strip. The notation of O. B. indicates the corner 
is outside the project boundary.  
 
The Stake report provides the coordinates of the northwest corner of each grid. At this stake point, the 
existing elevation, proposed elevation and the depth of the cut and/or fill are provided. As noted 
previously, the grid can be aligned to the project boundary or to a specific point. To align the grids with 
a certain coordinate, see Step 8 - Digitize the Project Boundary.  
 
The data on the Grid Data tab may be exported to a number of formats by clicking the Export… 
button.  
 
The Export Surface and Export DWG commands require control points at the Import/Export section 
of the Drawings tab. Surface points, aligned with a defined spacing setting, with elevations and 
locations are exported as a DWG or CSV file by clicking the Export Surface command. The Export 
DWG command, creates a DWG file of the contour lines, points and areas along with positioning 
coordinates and elevations. Both Export Surface and Export DWG create files used for developing 
machine control models.  
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L. 	Soil	Analysis	Tab	

The Soil Analysis tab is active when borings logs are used. As a result, this Soil Analysis tab will be 
covered under the Boring Logs chapter.  
 

M. 	Trenches	

SiteWorx/OS calculates trench volumes. The cut and backfill volumes from trenches are reported 
separately and are NOT included in the cut and fill volumes displayed at the Calculations tab. After 
digitizing the trenches, view the trench information and volumes, by selecting Trench and Trench 
definition from the Reports menu.  
 
SiteWorx/OS provides four options for the existing surface elevation used when calculating Trench Cut 
and Fill for Pipe/Conduit trenches. These options are made at the Project tab and follow: 
 

 Proposed Elevation: Use this option if trenches are excavated after site work is complete. 
(This is the elevation used in previous versions of the program.)  

 Proposed Elevation before Topsoil Respread: Use this option if trenches are excavated after 
the site work is completed, but before topsoil is respread.  

 After Cut, Before Fill: Uses the proposed elevation, before topsoil respread, where there is cut 
and the existing elevation, after topsoil strip, where there is fill. Use this option if trenches are 
excavated after site cuts are made, but before site fills are completed.  

 Existing Elevation after Topsoil Strip: Use this option if trenches are excavated first from the 
existing site. 

To digitize a trench, select Trench from the list of objects on the Takeoff tab toolbar and ensure the 
Show Elevations/Property Dialog and the Show Trench Definition Dialog are turned on under the 
Options menu. Next, at the top of the screen, enter the inverse elevation for the beginning of the trench. 
The invert elevation is the trench elevation at the bottom of the trench or bottom of the pipe depending 
on the setting defined at the Project tab. Click the Start takeoff, lightning bolt button and the Define 
Trench dialog box appears.  
 

 
	
Please note: 

	
 Define the line colors, width and type of trench. SiteWorx/OS handles three types of trenches: 
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V Bottom Drain, Flat Bottom Drain and Pipe/Conduit. After selecting the trench type, click 
on the dimension boxes and enter the various dimensions.  
 

 When clicked on a dimension box, the measurement required will be displayed in red on 
the left side under the Schematic tab.  

 
 After all dimensions have been entered at the Schematic tab, the cross section of the trench 

based on the dimensions actually entered will be displayed at the Actual tab. Once the trench 
has been defined, press the OK button. Next, digitize the next point along the trench line.  

 
 Whenever any two invert elevation points are recorded, SiteWorx/OS can calculate the 

invert elevations of the other points digitized by applying the calculated slope between those 
two points. A trench requires a minimum of two points with non-calculated invert elevations. 
The elevations of all other points can be calculated based on the slope between the two known 
points. This is accomplished by checking the Calculate Invert Elevation checkbox found 
on the elevation dialog box. In summary, enter the actual inverse elevation in the Inverse 
Elevation box or calculate the elevation by checking the Calculate Inverse Elevation 
checkbox. To use the Calculate Invert Elevation checkbox, the actual elevation must be 
entered in two places: at the start of the trench and anywhere else along the trench line. In 
this example, click the Calculate Invert Elevation check box on all trench line points 
except the first and last points on the trench line. At the end of the trench, the actual invert 
elevation will be entered and the calculate invert elevation checkbox will be unchecked. 

 
 After digitizing or calculating the elevations of the trench, press the right mouse button and select 

Stop Takeoff to complete.  
 

 Once complete, view and print the trench reports under the Reports menu. The location of the 
trench in relationship to the surface elevations for pipe trenches is available at the Cross 
Sections tab Trench Selection. Again, the trench volumes appear only on the Reports menu | 
Trench …. The trench volumes are not included in the site excavation cut and fill volumes 
displayed on the Calculations tab or on the other reports.  

	

N. 	Summary	and	review	the	reports	

In summary the takeoff process with SiteWorx/OS works as follows: 
 

1. Complete the Project Tab 
2. Open the Drawing(s), scale and align at the Drawings tab if more than one drawing. 
3. Click on the Takeoff tab define the project boundary and digitize elevations and areas.  
4. Click on the Calculations tab and set the grid size, resolution and then calculate.  
5. Review the calculated results at the 3D View, Cross Sections, Grid Data and Soil 

Analysis tabs.  
6. If changes need to be made, select the object or use the Checking | Examine menu to 

edit the information on the right side of the Takeoff tab 
7. Once the data appears reasonable, recalculate the project with High or Very High 

resolution.  
8. Finally, print the desired reports found under the Reports menu on the toolbar.  
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O. 	Boring	Logs	

 
Boring logs must be setup and entered when cut volumes by soil type are needed. Boring logs are 
required for calculating rock volumes. SiteWorx/OS uses the data from boring logs to model the 
soil layers (strata) found on the site. The data entry process involves digitizing the boring location 
and entering the data for the soil types per the boring log.  
 
Entering Borings for the Tutorial Project 

 
To enter boring log data to the tutorial project recently completed, perform the following: 

 
1. Save this tutorial project as a different name by clicking on File | Save Project As…. 

and name this project new project Tutorial w borings.ves for example.  
2. At the Takeoff tab, Select Topsoil Strip and delete the topsoil strip region since topsoil 

is defined by the boring logs.  The delete object button is found on the right side of the 
window to the immediate right of the green checkmark. 

3. At the Drawings tab, right click the mouse overtop the drawing displayed and select 
Duplicate Drawing. Change the page number on the toolbar to 3. Next, select Page 1 
from the Active Drawing list, change back to Page 3 and click the Align Dwg. button 
to align page 3 to pages 1 and 2.  

4. Print or view on a second monitor the boring logs noted on the Appendix at the end of 
this tutorial.  

5. At the Project tab, click on Yes at Borings Logs and then click Setup.  
6. Setup the boring log data entry and soil types as noted on the Sample Project Boring 

Logs found at the end of this tutorial. Please note that if a soil stratum is a topsoil or 
rock layer, check the Topsoil or Rock box when setting up the Soil Types. 

7. After setting up the borings and soil types at the Project tab, digitize the boring 
location and soil types by selecting Boring Log at the Takeoff tab.  

8. When done entering the borings and soil depths, calculate the project and look at the 
Soil Analysis tab and Reports | Cut by Soil Type to review the results.  
 
 

Entering Boring logs is a three-step process: 
 

1. Look at the logs and set up the data entry at the Project tab. Boring logs present the soil 
strata depths several ways. Sometimes the log shows no surface elevation. Sometimes the 
elevation at the bottom of the strata is shown. Other logs may show the depth of the strata 
below the surface. The choice of which depth or elevation to enter depends on the actual 
boring logs and is defined at the Setup tab shown below.  
 
At the Project tab toolbar, click Yes for boring logs and then click on Setup… to define 
the boring log information setup.  
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Again, before setting up the bore log data entry, look at the boring logs and see how the 
strata depths are shown on the logs. Defining how the strata data will be entered from the 
bore logs is important. How are the elevations displayed?  

2. Go through the boring logs and enter the different soil types. Click the Soil Types tab to 
enter the soil types.  

 

At the Soil Types tab, name the soil type and define its colors, fill patterns and swell 
factors. If a soil type must be exported and removed, do not check the Use for Fill 
checkbox. Only one layer, (i.e. the top layer) can be defined as the topsoil layer. If a 
layer is rock, check the Rock box when setting up the soil types. The colored buttons at 
the bottom of the window are for additions, deletions and recording this tabular 
information.  

 

3. Go through the boring logs and enter the strata by clicking the Takeoff tab, Boring Log 
selection, and record the location of the bore holes along with the strata depths.  

 

 
Like the Soil Type setup, the colored buttons at the bottom of the window are for 
additions, deletions and recording this tabular information.  

 
Boring Log Results 

  
When using boring logs, SiteWorx/OS calculates the cut volumes for each soil type. These results 
can be viewed at Reports menu | Cut by Soil Type. Additionally, a graphic presentation of the 
soil strata is shown on the Soil Analysis tab.  

  
Notes about Boring Logs 

  
Using Boring Logs changes some aspects of SiteWorx/OS: 
  

 Topsoil Strip Areas are not used. Check the Strip Topsoil box in Boring Log Setup to 
strip the site of the topsoil layer.  

 Topsoil Swell Factor at the Calculations tab is not used.  
 Site balancing is not available.  
 Subsoil Report is not available.  

 



37 

P. Importing	objects	and	elevations	from	DWG	files	

 
SiteWorx/OS imports objects from AutoCAD DWG files. If you have a DWG file, much of the 
information can be imported directly from the file rather than using the mouse to digitize the 
objects. To import objects from a DWG file: 
 

a) Click on the File menu/icon | New Project. At the Project tab, name this project DWG File 
Import or whatever. When clicking on the Drawings tab, you’ll be asked to save changes to 
current project? Answer Yes, and then name this SiteWorx/OS project file as DWG 
Import.ves. At the Drawings tab, Open… Top of Curb.dwg file and select foot as the CAD 
drawing unit after clicking the Scale button. This Top of Curb.dwg file is located at 
C:\Users\Public\Public Documents\Vertigraph\SiteWorxOS\Drawing Files. 
 

b) At the Takeoff tab, the Included Project Boundary must be digitized using the mouse before 
importing CAD objects. Before digitizing the Project Boundary, insure that Select Entity and 
Snap to Entity Point on the CAD section of Takeoff tab toolbar are turned off. After 
digitizing the perimeter of the project boundary, click the Stop Takeoff command.  
 

c) Since contour lines will be imported from the DWG file, select Contour Line and then 
Existing as the Takeoff type from the Takeoff toolbar. Next, the exiting contour lines must be 
isolated. When working with CAD files such as AutoCAD DWG files, show the layers on the 
left side of the Takeoff tab window by turning on the Display the Layer List command from 
the CAD section of the toolbar. The width of the layer list is resized using the mouse. As 
noted previously, to isolate a layer, click the Select Layers button from the CAD section of 
the Takeoff toolbar, move the mouse pointer overtop an existing contour line, right click the 
mouse and click Hide Other Layers from the popup menu. Only the existing contour lines 
should display after hiding the other layers. After selecting the desired layer, turn OFF the 
select layers command at the CAD section of the toolbar. 

 
d) SiteWorx/OS imports contour lines and points with elevations directly from DWG files. Before 

importing, make sure that the CAD menu | Use Z axis for Elevation is turned on (i.e. checked) 
so that the elevations associated with the entity will also be imported. Importing entities is a 
process where the appropriate object is selected at the Takeoff tab, the drawing layer pertaining 
to the object is displayed, and the data for the selected object is imported by clicking the 
Import from drawing into takeoff command on the CAD section of the Takeoff toolbar.  
 

e) In this example we’ll import the existing contour lines, then change to proposed and isolate the 
proposed contours lines and import the proposed.  Next, we’ll change the takeoff selection to 
Point Elevation, isolate the DESIGN POINTS layer and then press the Import from drawing 
into takeoff command from the CAD section of the toolbar ribbon. Also, please insure the 
Select layers command is turned off prior to clicking the Import from drawing into 
takeoff command. 
 

f) To record Area Elevations, please note: 
 Sometimes areas are not properly closed to the first point by the creator of the DWG 

file. As a result, area elevations are often digitized from the DWG file using the Snap 
to Entity Point command from the CAD section of the toolbar rather than importing 
the area. Click the Snap to Entity Point command on the CAD section of toolbar to 
turn on this feature.  

 To digitize areas, make sure that Options | Use Z Axis for Elevation is not on and 
Options | Show Properties/Elevation Dialog is clicked on.  

 Use the CAD | Layers List menu to display the desired areas or isolate the layer from 
the drawing using the Select Layers command from the CAD section of the toolbar. 
Please display the SLAB_ANNOT, SLAB_ON_GRADE, PK_LOT and 
PK_LOT_ANT layers. 
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 Once the proper layers are displayed, click the Start Takeoff action and click a corner 
of the slab and the Area Elevation Properties dialog should display. In the dialog box, 
record a Proposed Elevation of 107. 33, set the Area Type to Surface, enter a 4 for 
Overcut, .33 for Above Grade, change the Color, select a Fill Style by clicking the 
three-dot lookup button, name that area “SLAB” and finally, click the OK button. 
Click on the next three corners and when completed, right click the mouse and select 
Stop Takeoff. On the right side of the window, click the Layers tab and input the 
material layers of concrete with a depth of .5 and Select fill with a depth of 2 which is 
applied to the overcut area by checking the Include Overcut checkbox. When 
completed, click the checkmark at the bottom of the window to record the changes to 
the material layer list. 

 After digitizing the building, digitize the parking lot as a subgrade only area and record 
the layers of .5 for curb height and .5 for asphalt and base.  

  
g) After importing the contour lines and points, and after digitizing the areas, verify that all 

elevations are properly recorded and within range by looking at the 3D View tab. Sometimes, 
and depending on the how the file was created, some elevations will be recorded with a zero 
value. At the Takeoff tab, select the object (e.g., Contour Line) and then click Checking | 
Examine followed by Checking | Below Minimum to ascertain that all elevations are properly 
recorded. The Max and Min Elevations are defined under the Checking menu. After clicking 
the Checking | Below Minimum command, the initial item found that is below the minimum 
elevation will display on the right side of the window. Click on the Delete selected object 
button on the right side of the window to delete this incorrect elevation item and move to the 
next item. And remember, please make sure that the Min and Max Elevation are properly set 
under the Options menu.  

 

Congratulations, you’re now ready for a real project.  
 
Any questions, comments or suggestions, please contact us at any time. We wish you the best of 
everything.  
  

Vertigraph, Inc.  
12959 Jupiter Road, Suite 252 
Dallas, TX 75238 
214-340-9436 
800-989-4243 
support@vertigraph.com 
www.vertigraph.com 
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Q. Appendix	‐	Sample	Boring	Logs	

At the Project tab, setup the following soil types when recording borings: 

Listing of Soil Types (assume all soil types have a swell factor of 1.31): 

Soil Type Topsoil Use for Fill Rock 
Grass and Topsoil Yes No  

Clay  Yes  

Limestone  No Yes 

 

List of Borings: 

Boring ID: B-1  Surface elevation: 104.10 

Soil Type Description Elevation at top of strata Depth in feet below surface 
Grass and Topsoil 104.10 .50 

Clay 103.60 4.80 

Limestone 99.30 8.00 

 

Boring ID: B-2  Surface elevation: 104.20 

Soil Type Description Elevation at top of strata Depth in feet below surface 
Grass and Topsoil 104.20 .50 

Clay 103.70 2.50 

Limestone 101.70 8.00 

 

Boring ID: B-3  Surface elevation: 104.50 

Soil Type Description Elevation at top of strata Depth in feet below surface 
Grass and Topsoil 104.50 .50 

Sandy Lean Clay II 104.00 3.50 

Limestone 101.00 8.00 

 

Boring ID: B-4  Surface elevation: 105.00 

Soil Type Description Elevation at top of strata Depth in feet below surface 
Grass and Topsoil 105.00 .50 

Clay 104.50 4.00 

Limestone 101.00 12.00 

 

Boring ID: B-5  Surface elevation: 107.40 

Soil Type Description Elevation at top of strata  Depth in feet below surface 
Grass and Topsoil 107.40 .50 

Clay 106.90 3.00 

Limestone 104.40 8.50 
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Boring ID: B-6  Surface elevation: 101.00 

Soil Type Description Elevation at top of strata Depth in feet below surface 
Grass and Topsoil 101.00 .50 

Clay 100.50 5.00 

Limestone 96.00 8.00 

 

Boring ID: B-7  Surface elevation: 100.60 

Soil Type Description Elevation at top of strata Depth in feet below surface 
Grass and Topsoil 100.60 .75 

Clay 99.85 4.00 

Limestone 96.60 10.00 

 

Boring ID: B-8  Surface elevation: 99.20 

Soil Type Description Elevation at top of strata  Depth in feet below surface 
Grass and Topsoil 99.20 .75 

Clay 98.45 3.00 

Limestone 96.20 15.50 

 

Boring ID: B-9  Surface elevation: 104.20 

Soil Type Description Elevation at top of strata Depth in feet below surface 
Grass and Topsoil 104.20 .50 

Clay 103.70 9.80 

Limestone 94.40 12.00 

 


